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Setting Up LabQuest 2 for Data Sharing

1. Before using your new LabQuest 2, remove the pull tab, which protects the battery during shipping, from the back of the unit.
2. Connect the power adapter. 
3. Charge for at least 12 hours.
4. Then turn on LabQuest 2.
5. Tap the Home icon, and then tap the Preferences folder, then Orientation. Tap on the horizontal and upright screen position icon on the upper left side to lock this view.
6. Tap the Home icon to exit out of this menu and again tap the Preferences folder, then Light & Power. Adjust the Backlight on Battery Power to about 75%, and set the power to Dim after 5 min and Turn off after 30 min.
7. Tap on the Wi-Fi icon to adjust the Connections. Turn on Wi-Fi if it is not already done. Tap on the gear icon next to Network. [In order to share data between the LabQuest 2 unit and other mobile devices, they must all be connected to the same network! You may either use a password protected network (such as that of your school) or an unprotected adhoc network that shares a common Wi-Fi hotspot, such as a router that is not connected to the Internet.] Connect the LabQuest 2 to your chosen network, and then tap OK.
8. Tap the gear icon next to the Name of your LabQuest and change it to a unique name that identifies your specific device, such as "LabQuest7". It is suggested that you place this name on the outside of the unit, as well, to aid in identifying your device.
9. Tap on Data Sharing and make sure it is turned on, but do not check the box to allow connected devices to Start/Stop data collection. Tap OK.
10. Tap on Viewer and make sure it is turned on, and that the box to Allow screen control is checked. Steps 9 and 10 will allow the teacher to control any LabQuest device, but restrict student control. Tap OK.
11. Note that your LabQuest 2 device is assigned a unique Data Sharing Source Address that is accessible through a web browser by entering the http: address or by using a QR reader to link together using the code.
12. Connect a sensor. The sensor auto-IDs and displays a live readout. The default collection rate for the sensor is set up.
13. Tap the green arrow to Collect and data collection begins.
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LabQuest Viewer (version 2.0) Software
LabQuest Viewer v2.0 is computer software that displays and controls the screen of a LabQuest using a computer. When used in conjunction with a projector, this software can be used to demonstrate the functions of LabQuest and to enhance group presentations. This software can also be used to monitor student use of LabQuest devices in your lab, view and control a LabQuest remotely, and easily capture LabQuest screen images for use in lab instructions or assessment questions. 
LabQuest Viewer v2.0 Features 
· New My Lab view displays live images of all LabQuests in your lab.
· My Lab Setup allows you to add, arrange, and remove LabQuest devices in My Lab.
· Select up to four LabQuest devices for side-by-side comparison of experimental results from different lab groups
· Persistence of My Lab setup and software size/position values between sessions.
· Previous/Next buttons support quickly moving through LabQuest units while presenting.
· Capture and share screenshots of the LabQuest screen for use in lab instructions and assessment questions
· Purchase of a single copy of LabQuest Viewer software includes a site license for all
computers in a school or college department.
Note: Full software support for Mac OS X 10.10. Version 2.0 and newer does not support Windows XP or Vista. Users of these operating systems must continue using LabQuest Viewer software version 1.1. 
Set up LabQuest 2 to work with LabQuest Viewer software via Wi-Fi
1. 	Connect to a Wi-Fi network.
a. 	Tap Connections on the Home screen, then tap the Network gear icon. Turn on Wi-Fi.
b. 	Tap on the desired network to connect to that network. Enter a passphrase, if required. Note: If no there are no networks available, select Create Network… to set up an ad-hoc network. For more information, see www.vernier.com/networking
c. 	Close the Network Configuration screen.
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2. 	Enable Data Sharing.
a. 	Tap Connections on the Home screen, then tap the Data Sharing icon. Turn it on.
b. 	Do not check the box to allow connected devices to Start/Stop data collection unless you want to enable this remote control feature. This limits the data sharing to only permit the download of stored data to other devices.
c. 	Close the Data Sharing Configuration screen.


[image: ]
[bookmark: OLE_LINK2][image: ]3. 	Enable Viewer support
a. Tap Connections on the Home screen, then tap the Viewer gear icon.
b. Verify the LabQuest Viewer option is On and Allow screen control is selected. This permits the teacher to access any of the student LabQuest units and to remotely perform any operation on the devices.
c. Close the LabQuest Viewer Settings screen.


LabQuest Viewer is part of the Connected Science System. An example of the Viewer screen that can be displayed through the teacher's computer is shown below:
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Each display can be viewed separately, and Screenshots are copied to the Clipboard to allow them to be pasted into a Word document as a Picture or pdf format.
 

Watershed Testing
There are many reasons for determining water quality. You may want to compare the water quality upstream and downstream to locate a possible source of pollutants along a river or stream. Another reason may be to track the water quality of a watershed over time by making measurements periodically. When comparing the quality of a watershed at different times, it is important that measurements be taken from the same location and at the same time of day.
In 1970, the National Sanitation Foundation, in cooperation with 142 state and local environmental specialists and educators, devised a standard index for measuring water quality. This index, known as the Water Quality Index, or WQI, consists of nine tests to determine water quality. These nine tests are; temperature, pH, turbidity, total dissolved solids, dissolved oxygen, biochemical oxygen demand, phosphates, nitrate, and fecal coliform. A graph for each of the nine tests indicates the water quality value (or Q-value) corresponding to the data obtained. Once the Q-value for a test has been determined, it is multiplied by a weighting factor. Each of the tests is weighted based on its relative importance to a stream’s overall quality. The resulting values for all nine tests are totaled and used to gauge the stream’s health (excellent, good, medium, poor, or very poor).
While the WQI can be a useful tool, it is best used in light of historical data. Not all streams are the same, and without historical data it is difficult to determine if a stream is truly at risk. For example, a stream may earn a very low WQI value and appear to be in poor health. By looking at historical data, however, you may find that samples were collected just after a heavy rain with an overflow from the local city sewer system and do not accurately reflect the stream’s health.
In this experiment, your students will be performing six core WQI tests: dissolved oxygen, total dissolved solids, turbidity, pH and nitrate. A modified version of NSF WQI Worksheet for these six tests will allow your students to determine the general quality of the water source being sampled.

OBJECTIVES
In this experiment, you will
· Use a Turbidity Probe, Dissolved Oxygen Probe, Conductivity Probe, Temperature Probe and a pH Sensor to make on-site measurements.
· Perform a LaMotte nitrate kit wet lab test to make on-site measurements.
· Calculate the water quality based on your findings.
MATERIALS
	LabQuest 2
	Vernier Conductivity Probe

	LabQuest App
	Vernier Dissolved Oxygen Probe

	water sampling bottles
	Vernier pH Sensor

	large plastic cup or beaker
	Vernier Turbidity Probe

	LaMotte Nitrate test kit
	Vernier Temperature Sensor


Collection and Storage of Samples
· These tests can be conducted on site or in the lab. Obtain the sample in a bottle that has a lid to allow for gentle mixing just prior to testing. Approximately 100 mL of water is required. Make sure that there are no air bubbles in the water-sample container and that the container is tightly stoppered. 
· It is important to obtain the water sample from below the surface of the water and as far away from the shore as is safe. If suitable areas of the stream appear to be unreachable, samplers consisting of a rod and container can be constructed for collection. 
· 
Stand upstream from any activity that could stir up sediment and affect your readings. Hold the sample bottle upstream from your body.
· If the testing cannot be conducted within a few hours, place the sample in an ice chest or a refrigerator. Storing water samples for later testing decreases sample accuracy and is only recommended in cases where measuring at the site is not possible.
Calibration and Set-up of Sensors Procedure
1.	Set the switch on the Conductivity Probe box to 0–2000 µS/cm. Connect the Conductivity Probe, pH Sensor, and Turbidity Probe to LabQuest. Choose New from the File menu. It is necessary to warm up the Turbidity Probe for 5 minutes before taking readings. The probe must stay connected at all times to keep it warmed up.
2. Initiate GPS, if desired, by enabling the internal GPS using the instructions below:
a. Choose Sensor Setup from the Sensors menu.
b. Select the GPS check box and tap OK. Hold the LabQuest with the screen facing upwards toward open sky.
c. It may take a few minutes for the GPS to acquire satellites.
3. On the Meter screen, tap Mode. Change the Mode to Data Matrix.
4. Set up the matrix.
a. Data Matrix defaults such that rows of the data table correspond to the sampling sites and runs correspond to the collection day. Either accept the default names of Site and Day or enter alternates.
b. Another default setting is for LabQuest to automatically increment the Site and Day names, e.g., Site 1, Site 2. If you do not want this behavior, select the Automatically increment numbers box to clear it.
c. Tap the green arrow to start data collection. The Change screen will launch, allowing you to change or add sites and days. If the Automatically increment numbers box was not checked, you will need to add at least one of each site and day.
d. You may add all of the anticipated sites and days at this time, or they can be added later. Once your matrix is established, you can toggle between Sites or Days and collect new data or change existing data.
e. Tap Continue.
f. Tap OK.
5. Calibrate the Conductivity Probe.
· If your instructor directs you to use the stored calibration, proceed directly to Step 7.
· If your instructor directs you to perform a new calibration for the Conductivity Probe, proceed to Step 5a. Note: It is recommended that the calibration be performed prior to going into the field.
First Calibration Point
a. Tap on the Conductivity Meter Screen and choose Change units. Select mg/L.
b. Choose Calibrate from the Sensors menu and select Calibrate Now.
c. Hold the probe in the air (out of any solution) and enter 0 as the mg/L TDS value for Reading 1.
d. When the voltage reading stabilizes, tap Keep.

Second Calibration Point
e. Rinse the Conductivity Probe with distilled water into a waste container. 
f. Place the probe into the 500 mg/L TDS standard solution. The hole near the tip of the probe should be covered completely. 
g. Enter 500 as the mg/L TDS value for Reading 2. 
h. When the voltage reading stabilizes, tap Keep.
6. Save the calibration onto the sensor.
a. Select the Storage tab. 
b. Tap Save Calibration to Sensor and follow the onscreen instructions to save the calibration.
c. Tap OK.
d. Rinse the Conductivity Probe with distilled water into a waste container.
e. If the test will not be completed immediately, gently dry off the probe and store properly.
7. Calibrate the pH Sensor.
· If your instructor directs you to use the stored calibration, proceed directly to Step 9.
· If your instructor directs you to perform a new calibration for the pH Sensor, proceed to Step 7a. Note: It is recommended that the calibration be performed prior to going into the field.
First Calibration Point
a. Tap on the pH Meter Screen and choose Calibrate from the Sensors menu and select Calibrate Now.
b. Remove the sensor from the bottle by loosening the lid, then rinse the sensor with distilled water into a waste container.
c. Place the sensor tip into pH 4 buffer. Enter 4 as the known pH value for Reading 1. WARNING: May be harmful if swallowed or in contact with skin.
d. When the voltage reading stabilizes, tap Keep.
Second Calibration Point
e. Rinse the pH Sensor with distilled water into a waste container.
f. Place the sensor tip into the pH 10 buffer. Enter 10 as the known pH value for Reading 2.
g. When the voltage reading stabilizes, tap Keep.
8. Save the calibration onto the sensor.
a. Select the Storage tab.
b. Tap Save Calibration to Sensor and follow the onscreen instructions to save the calibration.
c. Tap OK.
d. Rinse the pH Sensor with distilled water into a waste container.
e. If the test will not be completed immediately, replace the sensor in its storage solution.
9. Calibrate the Turbidity Sensor.
· If your instructor directs you to manually enter the calibration values, tap Equation. Enter the values for the Slope and the Intercept obtained from a previous calibration. Select Apply to make the changes take effect and select OK. Proceed directly to Step 10.
· If your instructor directs you to perform a new calibration for the Turbidity Sensor, follow this procedure.


First Calibration Point
a. Select Calibrate Now.
b. Prepare a blank by rinsing the turbidity cuvette with distilled water, then filling it with distilled water so that the bottom of the meniscus is even with the top of the white line. Place the lid on the cuvette. Gently wipe the outside with a soft, lint-free cloth or tissue.
c. Check the cuvette for air bubbles. If air bubbles are present, gently tap the bottom of the cuvette on a hard surface to dislodge them.
d. Holding the cuvette by the lid, place it in the Turbidity Sensor. Make sure that the mark on the cuvette is aligned with the mark on the Turbidity Sensor. Close the lid.
e. Enter 0 as the known turbidity value for Reading 1. 
f. When the voltage reading stabilizes, tap Keep.
g. Remove the cuvette and set aside for use in measuring the turbidity of your sample(s).
Second Calibration Point
h. Obtain the cuvette containing the Turbidity Standard (100 NTU) and gently invert it four times to mix in any particles that may have settled to the bottom. Important: Do not shake the standard. Shaking will introduce tiny air bubbles that will affect turbidity.
i. Wipe the outside with a soft, lint-free cloth or tissue. 
j. Holding the standard by the lid, place it in the Turbidity Sensor. Make sure that the mark on the cuvette is aligned with the mark on the Turbidity Sensor. Close the lid.
k. Enter 100 as the known turbidity value for Reading 2. 
l. When the voltage reading stabilizes, tap Keep.
m. Tap Equation to display the slope and y-intercept for the calibration and write down the y = mx + b values.
n. Select OK.
o. Save the calibration onto the sensor.
Data Collection Procedure
10. Start data collection by tapping the green arrow.
11. The Change screen will open, allowing a change or addition of sites and days. Note: These instructions use the default terms Site and Day.
· If the Automatically increment numbers box was not checked, at least one of each site and day must be added.
· All of the anticipated sites and days may be added at this time, or they can be added later.
12. Tap Continue.
13. If using GPS, tap the latitude or longitude meters to keep the location. The meter for that value will turn white and the padlock will close, indicating it has been kept in the file. If a mistake is made, tapping a second time will discard the value and open the padlock.
14. Place the tip of the conductivity probe into the sample water. The hole near the tip of the probe should be covered completely. Note: The handle is not waterproof. Submerge the sensor no more than 5 cm. 
a. Once the reading has stabilized, tap it to keep the value.
b. To measure the conductivity of a water sample from a different site, choose Change and select the Site and Day used to identify the new sample and measure the conductivity of the new sample. 
c. When finished with the Conductivity Probe, rinse the tip thoroughly with distilled water into a waste container and store properly.
d. Note: Once a value has been kept, that sensor can be disconnected and a different sensor can be connected in order to test other parameters, if desired.
e. Data collection can be stopped and restarted at any time. This is useful for reviewing the data table or graph for analysis purposes.
15. Ensure that the pH Sensor is connected to LabQuest and that the correct date and location are displayed, if using Data Matrix mode.
a. Unscrew the storage bottle cap and gently remove the pH Sensor. Rinse the tip thoroughly with distilled water into a waste container.
b. Place the tip of the sensor into the sample water. Note: The handle is not waterproof. Submerge the sensor tip no more than 4 cm.
c. Once the pH reading has stabilized, tap it to keep the value.
d. Choose Change to measure the pH values of water samples from other Sites/Days, if necessary.
e. When finished with the pH Sensor, rinse the tip thoroughly with distilled water into a waste container and return to its storage solution.
16. You are now ready to collect turbidity data.
a. Gently invert the sample water four times to mix in any particles that may have settled to the bottom. Important: Do not shake the sample. Shaking will introduce tiny air bubbles that will affect turbidity.
b. Rinse an empty cuvette with sample water, then fill it with sample water so that the bottom of the meniscus is even with the top of the white line. 
c. Place the lid on the cuvette. Gently wipe the outside with a soft, lint-free cloth or tissue.
d. Check the cuvette for air bubbles. If air bubbles are present, gently tap the bottom of the cuvette on a hard surface to dislodge them.
e. Holding the cuvette by the lid, place it into the Turbidity Sensor. Make sure that the mark on the cuvette is aligned with the mark on the Turbidity Sensor. Close the lid.
f. Once the turbidity readings are stable, tap the padlock to keep the data value. 
g. Choose Change to measure the turbidity values of water samples from other Sites/Days, if necessary.
h. Pour out the water sample and rinse the cuvette thoroughly with distilled water. Gently dry the cuvette with a soft cloth.
17. Remove the sensors from the LabQuest and connect the Temperature Sensor and Dissolved Oxygen Probe in their place.
18. Submerge the tip of the Temperature Probe a few centimeters into the stream (or into a sample taken from the stream) and hold until the temperature is stable. Note: The handle is not waterproof. 
a. When the temperature is stable, tap it to keep the value. 
b. Choose Change to measure the temperature values of water samples from other Sites/Days, if necessary.
c. Note: If calculating the WQI (Water Quality Index), a second temperature reading taken one mile upstream from the first site is required to calculate the change in temperature between sites.
19. Ensure the Optical DO Probe is connected to LabQuest and that the switch is set to % (saturation O2).
a. Remove the entire storage bottle.
b. Place the tip of the sensor into the sample water. Note: The probe itself is waterproof, but the box with the switch is not.
c. Once the DO reading has stabilized, tap it to keep the value.
d. Choose Change to measure the dissolved oxygen values of water samples from other Sites/Days, if necessary.
e. When finished, rinse the tip thoroughly with distilled water into a waste container and return to its storage bottle.
20. 
To test for nitrate in water samples, perform a LaMotte Nitrate Test Kit. A chemical reaction occurs with available nitrate in the sample to produce a yellow-orange colored solution. This is then compared to a color chart of solution with known nitrate concentrations to find a match. Use the procedure outlined below:
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21.	Use the steps below to add the nitrate value to the Data Matrix file.
a. Tap the Table tab to display the data table.
b. Choose New Manual Column from the Table menu.
c. Enter Nitrate as the name and enter mg/L as the units. Tap OK.
d. Tap in the cell of the correct date and location the sample was collected. Manually enter the nitrate reading you have collected or calculated.
22. Once all the values for that site and day have been kept, either stop data collection, or tap Change to return to the Change screen. Note: Choose Change only if the next location is very close and additional data will be collected immediately. Otherwise, stop data collection and save the file.


Analyzing the Data
23.	The raw data can be viewed by navigating to the Table screen. Use the scroll bars to navigate around the table.
24.	The data can be graphed by doing the following:
a. 	Navigate to the Graph screen.
b. 	Tap on the y-axis label and select the parameter you wish to graph from the list.
c. 	Select the site or day of your choice from the chooser located at the upper right corner of the graph.
d.	To show two graphs at once, choose Show Graph from the Graph menu, and select All Graphs.
25.	If the data are currently graphed to compare locations, but a comparison of dates is desired instead, or vice versa, they can be transposed or pivoted(requires LabQuest App v.2.2 or newer). To pivot the data:
a. 	Navigate to the Graph screen.
b. 	Choose Advanced ► Pivot Data from the Analyze menu.
c. 	The pivoting will be reflected on the graph and in the data table.
DATA
	Water Source
	DO
(% sat.)
	pH
	Cond.
(µS/cm)
	TDS
(mg/L)
	Turbidity
(NTU)
	T
(°C)
	Tup
(°C)
	ΔT
(°C)
	NO3-N (ppm)

	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	



Q-Values
· Look up the Weighted Q-values corresponding to your data in Appendix A and record them in the following table. 
· Determine the Water Quality Index (WQI) of each water source by adding up the Weighted Q-values.
	Water Source
	DO
	pH
	TDS
	Turbidity
	NO3-N
	WQI

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	



AppenDIX A: Q-Values with Change in Temperature Data
Note: You may need to interpolate to obtain the correct Weighted Q-Values.
	DO
	Q-Value
	Weighted
	
	pH
	Q-Value
	Weighted
	
	TDS (mg/L)
	Q-Value
	Weighted

	(% sat.)
	
	Q-Value
	
	
	
	Q-Value
	
	
	
	Q-Value

	0
	0
	0.0
	
	2
	0
	0.0
	
	0
	79
	9.8

	10
	5
	1.8
	
	2.5
	1
	0.2
	
	50
	87
	11.4

	20
	12
	4.2
	
	3
	3
	0.6
	
	100
	83
	10.3

	30
	20
	7.0
	
	3.5
	5
	1.0
	
	150
	79
	9.6

	40
	30
	10.6
	
	4
	8
	1.5
	
	200
	73
	8.8

	50
	45
	15.8
	
	4.5
	15
	2.9
	
	250
	66
	7.9

	60
	57
	20.1
	
	5
	25
	4.8
	
	300
	60
	7.4

	70
	75
	26.5
	
	5.5
	40
	7.7
	
	350
	53
	6.4

	80
	85
	30.0
	
	6
	54
	10.3
	
	400
	47
	5.6

	90
	95
	33.6
	
	6.5
	75
	14.4
	
	450
	40
	4.8

	100
	100
	35.7
	
	7
	88
	16.9
	
	500
	31
	3.6

	110
	95
	33.6
	
	7.5
	95
	18.5
	
	>500
	20
	2.4

	120
	90
	31.8
	
	8
	85
	16.3
	
	
	
	

	130
	85
	30.0
	
	8.5
	65
	12.4
	
	∆T (ºC
	Q-Value
	Weighted

	140
	80
	28.3
	
	9
	48
	9.2
	
	
	
	Q-Value

	>140
	50
	17.6
	
	9.5
	30
	5.7
	
	0
	95
	16.9

	
	
	
	
	10
	20
	3.9
	
	5
	75
	13.1

	Turbidity (NTU)
	Q-Value
	Weighted
	
	10.5
	12
	2.3
	
	10
15
	45
30
	7.8

	
	
	Q-Value
	
	11
	8
	1.5
	
	
	
	5.3

	0
	98
	16.5
	
	11.5
	4
	0.8
	
	20
	20
	3.5

	10
	78
	13.0
	
	12
	2
	0.3
	
	25
	15
	2.6

	20
	61
	10.1
	
	< 2 or >12
	0
	0.0
	
	30
	10
	1.8

	30
	53
	8.8
	
	
	
	
	
	
	
	

	40
	46
	7.6
	
	
	
	
	
	
	
	

	50
	38
	6.3
	
	
	
	
	
	
	
	

	60
	34
	5.6
	
	
	
	
	
	
	
	

	70
	29
	4.8
	
	
	
	
	
	
	
	

	80
	25
	4.2
	
	
	
	
	
	
	
	

	90
	21
	3.5
	
	
	
	
	
	
	
	

	100
	17
	2.9
	
	
	
	
	
	
	
	

	>100
	5
	0.9
	
	
	
	
	
	
	
	


Example of Interpolating a Weighted Q-Value: If the % saturation of DO of a water sample has a value of 74%, the Weighted Q-value falls between 26.5 and 30.0, which are the values for 70% and 80%.



Use the following table to determine the Water Quality of each water source.
	WQI
	Water Quality

	91–100
	Excellent

	71–90
	Good

	51–70
	Average (or Medium)

	26–50
	Fair

	0–25
	Poor


Mapping the Data
26.	If you have Logger Pro available, you could also transfer the data from LabQuest to a computer. Logger Pro has more graphing and analysis options than LabQuest, such as bar graphs and the ability to insert images, as shown in Figure 1. If your file includes GPS coordinates, Logger Pro also has the ability to export your data into Google Maps. There are several ways to transfer the data from LabQuest to Logger Pro:
Using Data Matrix Mode
· Connect LabQuest to a computer running Logger Pro using a USB cable. If there is an active LabQuest session containing data, Logger Pro will prompt you to retrieve it. Click No. Retrieving remote data in this manner will not bring over your Run names. Instead, choose LabQuest Browser from the Logger Pro File menu and select Open. Choose from the list of saved files.
· Save the LabQuest file to a USB thumb drive or SD card, and then transfer the file onto your computer. Logger Pro will be able to open the LabQuest file.
[image: ]
Figure 1: Water quality data graphed and mapped in Logger Pro 

Storing LabQuest App Files & Opening in Logger Pro

LabQuest files have a .qmbl extension and can be saved to the internal storage space on LabQuest, or to an external storage space such as a USB Flash drive or a micro SD (Secure Digital) card. The drive or card may be formatted in FAT16 or FAT32 (the most common Windows and Mac OS formats) for reading and writing. LabQuest cannot read NTFS- or HFS+- formatted drives. LabQuest App files can also be opened and manipulated on a computer with Vernier’s Logger Pro software. 

To save a LabQuest App file 

1. 	Usually student data is saved to a USB flash drive or micro SD card. When a USB or SD card is plugged in, then by default the files will save to the last external storage device that has been added to the LabQuest device. Note: If no external storage device has been added, then the file will be saved to the internal storage of the LabQuest unit. 

2. 	Choose Save from the File menu. This opens a Save As dialog box. 

3. 	Tap on the appropriate icon to select your storage destination, if different than the default selection.

4. 	After selecting your destination tap on the name field to pull up the keyboard. Then enter the file name. 

5. 	Tap OK to return to the Save As screen. 

6. 	Tap Save to save the file.

7.	The drive can now be removed and inserted into the USB port of a laptop or desktop. Launch the Logger Pro program and choose the file that you want to open from the connected USB drive.

A second option to save the data from a LabQuest experiment is to use a USB cable to connect the LabQuest 2 unit directly to a computer that has Logger Pro software installed and opened to a new file. When the LabQuest is connected via USB cable, its screen will go blank then a double arrow icon will appear indicating that it is acting as a link between the probe(s) and the computer.

If the data collection experiment is still active, then you will be asked if you want to transfer the active data to Logger Pro, where you will then be able to perform more detailed analysis. If the file has already been stored on the internal memory of the LabQuest unit, then you can use the File pull down menu in Logger Pro to access the LabQuest Browser that allows you to select saved files that you wish to open. The features of the Logger Pro program are very similar to those of the LabQuest 2 App, but Logger Pro has more options for statistical and graphical analysis that may be required in advanced science classes.

Application: Use one of the methods described above to transfer the data collected while performing the previous experiment to the Logger Pro program that has been installed on a desktop/laptop computer. Compare the options for analyzing the data using the Logger Pro software to those available using the LabQuest 2 App.

Using Your Mobile Device to Access LabQuest 2 Data
[image: ]The wireless capabilities of LabQuest 2 allow lab groups to stream sensor data (via Wi-Fi) to multiple computers, tablets, and other mobile devices simultaneously. The Vernier Data Share Web APP is a web-based App that supports iPad, iPhone, iPod touch, Android phones and tablets, Chromebooks, notebook computers, and more. Data collection and analysis is performed in the browser with no store download required. The free Graphical Analysis APP has more functions than the Data Share Web APP, but operates in basically the same way.  

Using Vernier Data Share 
1. From the Home menu, tap Connections.

2.	Make sure the Wi-Fi and Data Sharing are turned on. Optionally, you can also choose to allow remote control of data collection on the LabQuest from the mobile device. 

3.	On your mobile device, connect to the same network to which LabQuest is connected. 

4.	Then open the browser on your mobile device and type in the Name for your LabQuest (e.g., LabQuestA.local) or the http address of your LabQuest.









  







[image: ]

Optional: If your mobile device has a QR-code reader, tap Connections from the Home screen on LabQuest. A QR-code associated with the HostName is displayed. Use a QR-scanning application on your mobile device to connect to your LabQuest.
To download data using the Graphical Analysis App 
1. 	Download the Graphical Analysis App to your device.
a.	For iPad, iPhone, and iPod Touch download from the Apple App Store. http://www.vernier.com/products/software/ga-app/
b.	For Android devices download from the Google Play Store.
c.	For Chromebooks download from the Chrome Web Store. http://www.vernier.com/products/software/ga-chrome/
2.	Open the Settings on your device and connect to the same Wi-Fi network as the LabQuest 2 device. (This information can be found in the Connections settings of the LabQuest 2.)
3.	Open the Graphical Analysis APP on your device and select Create Experiment.
4.	Click on Data Sharing and select the LabQuest 2 device with the same name as the one you used to measure your lab data. As an alternative, you can select Specify Source and either scan the LQ2's QR code or enter the LQ2's web address to download the data to your mobile device.
5.	Graphs and data can be saved as images and csv files to email, print, or paste into lab reports.  

WQI Data & Calculations Sheet
Stream or lake: 		Date:	
Site name: 		Time of day: 	
Site number: 		

	WQI Data Table

	
	A
	
	B
	C
	D

	Test
	Results
	Unit
	Q-Value
	Weighting
	Subtotal

	
	
	
	
	factor
	

	Temperature, T
	
	°C
	
	0.10
	

	pH
	
	pH unit
	
	0.11
	

	Turbidity
	
	NTU
	
	0.08
	

	Total Solids
	
	mg/L
	
	0.07
	

	Dissolved Oxygen
	
	% sat.
	
	0.17
	

	5-Day BOD
	
	mg/L
	
	0.11
	

	Total Phosphate
	
	mg/L PO4-P
	
	0.10
	

	Nitrates
	
	mg/L NO3–-N
	
	0.10
	

	Fecal Coliform
	
	CFU/100 mL
	
	0.16
	


					
	
	
	
	
	Score
	

	
	
	
	
	WQI Rating
	


Column Procedure: 
A. Record the test result for each test.
B. Using the weighted graph for each test, record the Q-value.
C. Multiply the Q-value in Column B by the weighting factor.
D. Record the resulting value of each test. Take the sum of the test subtotals and record the result at bottom of the table next to Score. Use the score to find the WQI Rating from the chart below.


	Water Quality Index Ratings

	90–100
	Excellent

	70–90
	Good

	50–70
	Medium

	25–50
	Poor

	0–25
	Very Poor
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